
21. TUTORIAL FOR GEODEMOGRAPHIC 
SITE PLANNING1

*   Tutorial 21, June 2005

CASE: J&J FAMILY VIDEO, P. 411

In selecting a physical location for a retail outlet, a fi rm makes two decisions: it chooses a 
market area, such as a city, region, or country, in which to establish the outlet, and then it 
chooses a specifi c site within that location. Because of the recent availability of computerized 
geodemographic databases, managers can use formal models, such as “gravity models,” in 
making location decisions. These databases overlay demographic, and other types of data 
(e.g., psychographic), on a geocoded database containing the latitude and longitude of most 
households in a specifi ed geographic area. 

The gravity model helps managers evaluate the combined effects of factors such as 
customer characteristics, store image, drive times, and the location of competing retailers, 
on the potential value of a site. Although gravity models have been around for many years, 
the recent development of geodemographic databases now make it feasible to apply these 
models to address a broad range of problems. Without the availability of these databases, 
it is diffi cult to specify exact geographic areas for analysis, and it is cumbersome to obtain 
distance and demographic data for a large number of geographic zones and retail outlets. 
Managers are no longer constrained to evaluate store attractiveness by traditional geographic 
units such as census tracts or zip codes. 

To develop a gravity model, you have to follow several general steps. The software 
allows you to implement these steps:

Step 1—Defi ne the market area
Identify a suitable geographic area that is likely to be served by the proposed outlet, and 
divide that area into its constituent zones. Ideally, the zones should be relatively homoge-
neous in their demographic characteristics and in the availability of competitive stores and 
movement barriers (e.g., rivers, railway lines, high-crime neighborhoods). 

Step 2—Obtain data about existing stores that are potential competitors to proposed 
outlet
In particular, get data on the location, size, sales, and other characteristics of each competing 
outlet within the market area.

Step 3—Compute distances
Compute distances from each store to each zone. The accompanying software automatically 
computes distances once the zones and locations of stores are specifi ed. 

Step 4—Calibrate the gravity model
Calibrate the gravity model on the existing competitors in the market area. Specifi cally, 
choose a set of parameter values for the Store Attractiveness coeffi cient (alpha) and the 
Distance Impact coeffi cient (Beta) that fi t the existing data well. Starting values can be 
alpha = 1 and beta = 1, unless there is reason to believe that other values are more likely to 
recover the current market shares of the competitors. 

 1  Unless you are running the Local Area Network (LAN) version of Marketing Engineering, you will need the 
Marketing Engineering (v 2.0) CD to run this software.
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Step 5—Evaluate sales potential of a new outlet at various locations
Introduce new outlet options at several proposed locations (this has already been done for 
the J&J Video exercise).

Step 6—Select the location of the new outlet
Select the location of the new outlet where sales potential or another measure of performance 
(e.g., profi t potential) is the highest.

SCAN/US

The gravity model in Scan/US uses a Microsoft Excel macro to evaluate the market shares 
for up to eighty sites in a single run. After you specify the location of the competing retail 
stores, the model can compute the required distances internally using its databases. However, 
you must provide an index of each store’s attractiveness. 

Scan/US is a comprehensive software program for geodemographic analysis. It includes 
a detailed online help fi le. Here we describe only the features that you will need for the J&J 
Family Video exercise. 

Note: To view or print a copy of the complete manual, you will need the original CD on 
which the Marketing Engineering software was distributed.
     If you do not have Adobe Acrobat™ Reader installed on your system,  you can install 
it by downloading the appropriate fi les from www.adobe.com or you can install the ver-
sion supplied with the Marketing Engineering CD in the directory…\adobe.
     After Acrobat™ is successfully installed, start the Acrobat program. From the File 
menu, select Open and open the fi le manual.pdf from the x:\scanus\manuals directory, 
where x is the letter representing your CD-ROM drive. Under the File menu, select Print 
to print any part of the manual. 

In the J&J Family Video exercise, you will build a gravity model to locate a new video 
store in the Phoenix, Arizona metropolitan area. This tutorial describes the three steps that 
you should follow to complete the exercise: 

� Setting up the data for the gravity model
� Using Microsoft Excel to build the gravity model
� Mapping the results of the gravity model

Insert your Marketing Engineering CD in the CD drive. From the Model menu, select 
Geodemographic Site Planning to see the following screen.

Note: You will not be able to run the Scan/US software online from our servers. Either 
you should have the stand alone version of Marketing Engineering supplied on a CD, 
or you must have access to the network version of Marketing Engineering that runs on 
local area networks. 
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STEP 1—SETTING UP THE DATA FOR THE GRAVITY MODEL

To set up the gravity model, you should fi rst create or load the specifi c geographical area 
with which you want to work with. Next, you add various types of data, called layers, to 
the specifi ed geography. You should then load a fi le indicating the locations of the retail 
sites (if it is not already loaded) as the location layer. We have completed these tasks for the 
J&J Family Video exercise. If this exercise is not automatically loaded when you open the 
program, go to the Map menu and select J&J Family Video Exercise.

Note: Gain familiarity with the software before you attempt to set up your own study area 
and retail site options. Follow the instructions available in the online Help menu. Briefl y, 
the steps are: (1) select an area of the US map for study, (2) select the geographic features 
you want to include for analysis (e.g., zip centroids, major streets), (3) indicate the loca-
tion of various retail sites of interest, and (4) create and name a new location layer.

Specify the set of competitive sites to be used in the analysis (Location Layer): Make loca-
tions the active layer by clicking on the arrow in the upper right corner of the screen and 
selecting J&J Video and Competitors.
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Next, select the set of retail sites (video stores) that you want to include in your 
analysis. To do this, fi rst defi ne a group that contains the selected stores. From the Groups 
menu, choose New Grouping, name the grouping (e.g., J&J Sites 1) and click OK. Go to 
the Groups menu, click New Group and name the group (e.g., All competitors). You can 
specify many different groups within one grouping.

Click OK. This should bring you back to the original screen and in group mode (click 
the group mode icon         on the left side of the screen, if it is not already activated). Now 
you are ready to specify the sites to be used for the analysis under the group name you 
provided. It is convenient to fi rst activate the Group-By Polygon submode       and draw 
a polygon around the selected video stores, including all the possible J&J Family Video 
Stores, by dragging the mouse while pressing the left mouse button. (For the present, select 
for analysis all the stores that you see on the screen.)

Specify the geographic area you want to include for analysis (Consumer Layer): Here 
you have two options: you can either specify the entire geography already included in the 
J&J Family Video exercise, or you can select a part of this area. The purpose of this step is 
to indicate to the software the geographical entities between which it should compute the 
distances (here from each MicroGrid to each video store).

Option 1: Using the entire geography in the J&J Family Video exercise: (Until you become 
familiar with the software, we suggest that you select the entire geography for analysis.) 
Here, simply copy the distances from the location layer (J&J Video and competitors) to the 
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consumer layer (MicroGrid layer), which contains information about where people live in 
the study area. To do so, make locations (i.e., J&J Video and Competitors) the active layer 
at the right upper corner of the screen. Go to the Objects menu and select Copy Distance. 
You will see the following box:

Copy the distance information from Objects in groups (e.g., J&J Sites 1 in All com-
petitors) to All objects on the consumer layer (MicroGrid layer) by choosing MicroGrids, 
©1993 Scan/US from the drop down menu under To objects on layer. Follow this last step 
carefully—otherwise, the proper set of distances will not be computed for the rest of the 
analysis.

Click OK to proceed.

Option 2: Using a subset of the geography in the J&J Family Video exercise: Instead 
of computing distances for all geographical units in the consumer layer, you can also fi rst 
create a group on the consumer layer and load the distance information from the location 
layer to the newly defi ned group on the consumer layer. To do this, click the arrow in the 
upper right corner of the screen and select the MicroGrid layer:

Go to the Groups menu and select New Grouping and give the MicroGrid grouping 
a name:



21. Tutorial 6

Click the Group-By Polygon button       and draw a polygon around the selected 
geography by dragging the mouse while pressing the left mouse button. Once you have 
defi ned a closed polygon, the system will ask you to give a name to the group, for example, 
MicroGrid group 1:

Click OK, and you will see a screen highlighting in red the area you selected:

To run the gravity model, you have to fi rst copy the data containing the distances of the 
stores to the MicroGrids, to the consumer layer (e.g., a selected group in the MicroGrids 
layer). This data is then made available to the Excel routine that runs the gravity model. You 
need to make sure that the location layer (i.e., J&J Video and Competitors) is activated by 
clicking the arrow in the right upper corner and choosing J&J Video and Competitors. Next, 
go to the Objects menu and choose Copy Distance. You will see the following box:
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Select Objects in group(s) and specify the group and the grouping in the MicroGrid 
layer you want to include in the analysis. If you select a small geographical area as a group, 
the gravity model will calculate estimates only for that specifi c group (area), thus reducing 
its computation time. Follow this step carefully – otherwise the proper set of distances will 
not be computed for the rest of the analysis. Click OK.

For the rest of this tutorial, we will assume that you selected Option 1.

STEP 2—USING EXCEL TO BUILD THE GRAVITY MODEL

You build the gravity model using a Microsoft Excel macro. First, you must enter data on 
store attractiveness indices for each site, as well as the store attractiveness and distance impact 
coeffi cients. The Scan/US Gravity Model Assistant, a Microsoft Excel macro, generates an 
output data fi le containing the gravity model probability (market share) estimates, which 
can then be displayed graphically within the Scan/US program. You can also combine the 
probability estimates in the Excel worksheet with other information to compute other indices 
of store performance at each location, the profi t potential at a location.

On Tasks menu, choose Build Gravity Model. Microsoft Excel will launch and bring 
up the Scan/US Gravity Model Assistant.
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Click Next. If you see a screen listing several fi elds for Attractiveness Index Data, select 
the Store ID fi eld. Click Next.
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Fill in the attractiveness index for each video store on a suitable scale (1-100 is typical, 
with higher numbers indicating more attractive stores) based on your best judgment about the 
attractiveness of each store. This index represents the intrinsic value of a store, independent of 
the ability of the customer to fi nd or come to that store. The attractiveness depends on many 
factors, such as the variety of titles offered, store atmospherics, and average price. In the 
J&J Video case, for example, you should have higher attractiveness indices for Blockbuster 
or Hollywood Entertainment, than for Video Connection or the Supermarket Store.

Click Next to get to this screen:

Enter your best estimates as to how store attractiveness (image) and distance infl uence 
store choice, choosing alpha and beta coeffi cients to refl ect these infl uences. The larger a 
coeffi cient, the higher is the relative infl uence of the corresponding factor. For example, 
the distance impact coeffi cient indicates how the ease of access to a store (site) would in-
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fl uence a consumer’s decision to buy from that store. The higher this coeffi cient, the faster 
the decline is in the consumer’s utility for a site as its distance from the consumer’s home 
base increases. For example, in a rural area, people commonly travel fi ve miles or more to 
a store; in a metropolitan area, they do not. The distance impact coeffi cient in a rural area 
might be 1.5, while in a metropolitan area it might be 2.0 or higher.

Note: For the J&J Video exercise, values of alpha and beta around 1.5 seem to be appropriate.

One way to determine whether your guesses for store attractiveness indices and distance 
impact coeffi cients are good is to check whether the resulting market share estimates for the 
existing stores (excluding the proposed new store altogether) correspond closely with the 
market shares for those stores in the chosen geographical area. In the J&J case, one way to 
assess this is to check the correspondence between market share estimates computed by the 
model and the estimates provided by Ms. Jackson.

You can choose a single value for the beta coeffi cient or choose multiple values in a 
selected range to represent varying degrees of infl uence of distance on store choice. For the 
latter case, click Use Incremental Values and specify the range:

(If you choose a range of values for distance impact, save each set of results under a 
different Excel 4.0 fi le at the end of the model run.)

Click Finish to continue.
The model now starts its computations by using the distances generated by Scan/US 

and the attractiveness indices, as well as the alpha and beta coeffi cients that you provided. 
Processing may take several minutes (or even hours) depending on the number of geographic 
entities included in the analysis. For the J&J Family Video exercise, it should take only a 
few minutes. The status bar at the bottom of the screen indicates the progress.

When data processing is completed, the Gravity Model Assistant prompts you to save 
your gravity model table. Change the path in the Save in box to the ...\MktgEng\Scanus\
Userdata folder and be sure to set the Save as Type to Microsoft Excel 4.0 Worksheet. Enter 
a fi lename and click Save.

Note: Do not save the fi le as an Excel 4.0 Workbook, which is also one of the fi le type 
options. Also, if you do not save this the data as an Excel 4.0 worksheet, the rest of the 
analyses described in the tutorial cannot be completed.
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The saved data fi le should look something like this:

At this point, you are given the option to restart the Excel macro to obtain model 
results under a different set of attractiveness indices and alpha and beta coeffi cients. To 
restart the Excel macro, click Back to the Beginning. Save each run under separate Excel 
4.0 worksheets.

Note: For the J&J Family Video exercise, you have to run the gravity model at least four 
times. In the fi rst run, include only the existing stores (i.e., set the attractiveness indices 
to zero for all three new sites being considered by Jack and Jeri) to calibrate the alpha 
and beta coeffi cients for the model. The next three runs are one for each new store loca-
tion under consideration (i.e., set attractiveness indices to zero for the two new sites not 
included in an analysis). 
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Click Exit to get back to Scan/US.

STEP 3—MAPPING THE RESULTS OF THE GRAVITY MODEL GRAPHIC

To view the model’s market share estimates in Scan/US, you need to load the gravity model 
results (which are in the saved Microsoft Excel 4.0 fi les) to the consumer layer (MicroGrids) 
and create a new thematic view.

1. Click the arrow in the upper right corner of the screen and choose MicroGrids (the 
consumer layer) from the drop down menu.

2. Go to the Data menu and choose Load Data. Switch to the \MktgEng\Scanus\User-
data folder and select one of the gravity model fi les you saved as Excel 4.0 worksheets 
(to change directories, check the Directories option fi rst). Click OK after you select 
the Excel fi le.
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If you click on the drop down menu for J&J Video Option 1%Mkt Share, you will 
see menu options that allow you to select a store to view its market share in each MicroGrid. 
If you select huffprob9:J&J Video Option 1% Mkt Share, then you can see the market 
share distribution across the MicroGrids for the fi rst store location.

3. Go to the Views menu and click New Thematic. 

Note: If you grouped objects in the consumer layer when you set up the model, be sure 
to select Analyze: Grouped objects in grouping to view the selected area. 

To more clearly see how each geographical area (MicroGird) contributes market share 
to a specifi c site that you select, you can stratify geographical areas using a color scheme. 
Click on the Strata Manager button       .        

You can change the market share range assigned to a particular color by dragging the 
appropriate black dumbbell up or down with the mouse. Here, we are separating the Mi-
croGrids into two groups. The fi rst group of MicroGrids provides a share of 10 percent or 
less for the new store in location 1, and the second group of MicroGrids provide a share of 
more than 10 percent. After you fi nish specifying the parameters, click OK.
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Click Groups and assign a name to the data grouping for the display that you cre-
ated. 

Click OK on all the open windows. You will now see the selected geography, highlighted 
with the color scheme you specifi ed, showing how market shares for J&J Video Store Option 
1 varies by geographical units. 
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Viewing a group’s data: You can also use Scan/US to aggregate the data for each object in a 
group to create a group summary. First, you must ensure that the data that you want to view 
are attached to the active layer. For example, if you want to investigate the results of the grav-
ity model, activate the MicroGrids layer by clicking on the arrow at the upper right corner 
of the screen and choosing MicroGrids, ©1993 Scan/US from the drop down menu. 

The market share estimates for each group are loaded into this layer. Next, click the 
group mode button        . Select an existing grouping or create a new group for which you 
wish to see summary information. For example, if you want to look at market share estimates 
for a specifi ed geographical area extending over several MicroGrids, you should build a 
group containing the MicroGrids that lie in the area of interest. You can then go to the Views 
menu and click QuickLook to see the data corresponding to the active group. The following 
screen shows the market shares for each competitor when we select only MicroGrids for 
which the new store in location 1 gets at least a market share of 10 percent. In particular, 
it shows that when we include those MicroGrids, the new store gets an aggregate market 
share of 18.82 percent across those MicroGrids.
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(Estimated %Market Shares gives the value for the primary contours, i.e., it is the 
highest market share estimate reached by any of the competitors in the set in any of the 
Microgrids.)

You can switch between viewing the data for the active group or the data for an object 
(e.g., a selected MicroGrid) by clicking on the “Show Group” button       or “Show Object” 
button       .

ADVANCED ANALYSES: CUSTOMIZING YOUR DATA IN EXCEL

You can get further insights about the sales potential of a store, if you combine the esti-
mated choice probabilities from the gravity model with other information available from the 
Scan/US database to create new indices of market potential for each store. For instance, in 
the J&J Video exercise, you can combine the probability estimates with the data regarding 
density of family households with children in each geographical area. You can also calculate 
potential sales by using the probability values and data from the Scan/US retail potential 
database. To conduct these analyses, use Microsoft Excel to create your own customized 
data set or to merge your data with the data provided by Scan/US. 

Note: There are various databases commercially available that offer information—beyond 
that contained in the Scan/US BasePak—that can aid your analyses (e.g., data about 
household expenditures by product category) Some of these databases (e.g., Scan/US 
retail potential database) come with this educational version of Scan/US but are restricted 
to the Washington DC and Phoenix, AZ areas. 

In the following section, we explain how to combine the data from a Scan/US applica-
tion with your own data. Principally, you need to know:

� How to group a subset of the Scan/US product databases and export it to Excel for 
further manipulation.

� How to prepare your own Excel data for import into the Scan/US program.
� How to display your data by creating a thematic view (see previous sections). 

SPECIFYING DATA FOR EXPORT TO EXCEL

First, you need to indicate which data to include in the analysis. The following example 
considers only the MicroGrids that have share estimates of more than 10 percent for the J&J 
Video Store Location Option 1. You can limit the amount of data to use in an analysis by 
“hiding strata.” Or, you can select a geographical area by grouping objects (e.g., MicroGrids) 
as we described earlier.

“Hiding strata” is a useful way of focusing an analysis on a specifi c set of objects. You 
can hide strata only when a variable’s strata, rather than data values, are being rendered by the 
thematic presentation. To prepare your data, go to the Views menu and click View Variables. 
Select J&J Video Option1%Mkt Share as the layer variable to be displayed. (You can 
repeat these analyses separately for each of the three store locations being considered.)
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To open the dialog box shown below, click the “Strata Manager” button      . Click the 
presentation icon next to the desired stratum, and a window shade will replace the color 
icon for the stratum (i.e., a hidden stratum has been created). Make sure that the data for the 
analysis is set to the J&J Video Option 1%Mkt Share in the top drop-down box.

Click on Groups button and save your data as a new grouping. 

Click OK (on several open windows). Next, from the Data menu, click Copy Data 
and copy the data to the Windows clipboard for Objects in groups. 
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Click OK. Now open Excel, place the cursor in row 1, column 1, and paste the data into 
the spreadsheet (use the Windows copy command or the key combination Ctrl+V). 

Exporting Scan/US demographic data: As an example, we will copy the “Average annual 
expenditure per household for videos, tapes, disks” variable from the Home Electronics 
datalist and the “Total Households (hh90)” variable from the data in the BasePak and paste 
the data into the spreadsheet shown above. 

For these tasks, the relevant data need to be available to the consumer layer. Several data 
lists can be loaded onto a layer (although only one can be active at a time). In this example, 
we use information from the Scan/US data lists on home electronics and key demographics, 
as well as the probability estimates from the gravity model. To load the home electronics data 
list, go to the Data menu in the Scan/US program, choose Data Center, select ’93 Home 
Electronics, and click the Load button (if the data is not already loaded). 
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Next, go to the Data menu and click Copy Data. Choose Home Electronics as your 
database in the drop down menu and select the variables that you want to copy into your 
spreadsheet. In this example, restrict the demographic data that will be copied to the strata 
group that you specifi ed earlier (e.g., J&J Video Option1%Mkt Share) or simply choose 
Filtered Objects. This ensures that only data for the MicroGrids that obtained choice prob-
ability values of more than 10 percent for J&J Video Option 1 will be copied. 

Switch back to Excel and paste the data into the spreadsheet, making sure that the data 
are copied beginning with the correct row (i.e., matched on key # given in column 1).

Similarly, copy the Total Households variable from the data in your BasePak and paste 
the data into the spreadsheet. 
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Now you can create variables that combine demographic information and choice prob-
abilities from the gravity model. To compute potential sales for J&J Video Option 1 for the 
“fi ltered” area (assuming that this is the primary trade area), multiply the column contain-
ing the probability values (the variable is called huffprob9 on the spreadsheet) by the Total 
Households and Average Annual Expenditure per Household for Video rentals, disks, and 
tapes. You can then total the potential sales across MicroGrids to derive an estimate for the 
total potential sales for the retail site under consideration. 

PREPARE YOUR OWN EXCEL DATA FOR IMPORT INTO SCAN/US
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When preparing your own Excel data for input to Scan/US, you need to ensure that 
your Excel data fi le meets the following specifi cations to make it readable by the Scan/US 
software: 

� Put your object keys in column A. An object key is a unique identifi er for each 
record that matches the data with the geographic object to which it pertains. These 
keys must be in text format. A pound sign (#) in front of numeric keys makes them 
“text.” (For best performance, sort the object keys in ascending order.)

� Your data columns must have column headings without any numbers in their 
names. 

� You must defi ne a named range called “database” that includes all the cells containing 
the column names, object keys, and data. You must complete this step, or Scan/US 
may not read your data correctly. If you modify the number of rows and columns in 
your data fi le, you must redefi ne the range of “database”.

� You must save your spreadsheet in Excel 4.0 format. For convenience, save it in the 
Scanus\userdata folder. Close the fi le before trying to import it into Scan/US.

DISPLAY IMPORTED DATA WITHIN SCAN/US

Now you can load your data into Scan/US, more specifi cally, to the layer that contains 
your object codes. In this example, make sure that MicroGrids is the active layer. Next, go 
to the Data menu, choose Load Data, and select the fi le you saved. You may then create 
thematic views to visualize your data and conduct further analyses. 
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GLOSSARY

Data: Scan/US provides census-based demographic data with most geographic features in 
the BasePak. Data are automatically loaded with each feature in a study area. 

Groups: By creating groups, you can classify objects on a layer into distinct and unique 
subsets. In general, you can select any group to operate on as a unit. For instance, you can 
copy, paste, hide, or show groups on a layer. 

A classifi cation of objects into groups is called a grouping. A grouping can consist 
of a number of groups. Because objects can be classifi ed in any number of ways, you can 
defi ne any number of groupings on the layer. You can create as many groupings as you like, 
limited only by the amount of memory on your computer. However, only one grouping can 
be active at a time on any given layer. 

Grouping objects is a powerful feature in Scan/US. As a fundamental tool for handling 
multiple objects, grouping is a fi rst step in analyzing a territory, or in limiting an analysis to 
a specifi c region. For example, you can examine sales across territories by creating a group 
for each territory, such as California, Washington, and Oregon in the western region/group, 
and then look at the group’s data in “QuickLook.” 

Layers: Geographic features, such as states, counties, roads, or geology, are loaded as lay-
ers into the study area, each feature on its own layer. In the gravity model application, there 
are special names for two of those layers: the consumer layer and the location layer. The 
consumer layer contains (demographic) geo-coded information about your clientele — at 
the level of detail needed for your analysis (e.g., mostly data provided by Scan/US, such as 
MicroGrids or block-level census data). The location layer contains information about the 
location of the sites that you wish to consider in your analysis. 

Each item of a feature on a layer is called an object. For example, California is an 
object on the Places 500T+ layer. Although several features or layers are present in a study 
area, only one layer can be active at a time. The terms feature and layer are often used 
interchangeably. 
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Object: A set of points, lines, or polygons in a spatial database that represent a real-world 
entity. 

Object key: An object key is a unique identifi er for each record. This key matches the data 
with the geographic object to which it pertains. You have object keys that match your data 
to standard geographical units, such as zip codes or census tracts. Or, you can have your 
own unique keys that identify your store or branch offi ce locations. 

REFERENCES

Scan/US Basic Skills, fourth edition, June 1996.
Scan/US User’s Guide, fi rst edition, December 1994. 

LIMITATIONS

MicroGrid data is available only for Phoenix and Washington, DC areas.


